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Sign In

To access Business Suite, Business Essentials, and other services (refer to the title page
for a complete list), go to cnb.com and click the Sign In button on the upper right.

(0 AboutUs [ ContactUs & Locations

CITy NATIONAL BANK

E’ Personal Business & Commercial Private Banking Insights Industries We Serve O\ m
I8 A RBC COMPANY

/

IT PAYS TO BE
PREFERRED.

Preferred Banking clients receive exclusive access to
complimentary wealth planning services, discounted
mortgage rates' and more.

LEARN MORE

Call us at (800) 773-7100 FIND A LOCATION

At the sign-in screen, enter your User ID and Password set up for you by your Company
Administrator, and then click Sign In, as shown below.
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Need Help? Personal Banking (800) 887-1290 | Business Banking (800) 599-0020

CITY NATIONAL BANK w

5 AN RBC COMPANY

SIGNINTO City National Online

ALL ONLINE SERVICES User ID

City National Online
Book2Bank
City National Card Alerts
City National Rewards
City National Visa Gift Card
City Tax &
CNB DX

Commercial AP D Remember my User ID
Commercial Card Online

Business Suite™

Business Essentials Password

Controlled Disbursement
Donor Advised Fund
EASI Link

International Banking Online

International Banking Online (FX) Forgot User ID?
Remit Advantage Forgot Password?
Remote Check Express
StuckyNet-Link

Wholesale Lockbox

NEW TO PERSONAL ONLINE BANKING?

ENROLL NOW

Account Setup

When signing on to the service for the first time, you will be guided through Account
Setup and Personal Information and Security Setup, which will assist you with verifying
and configuring your profile.

Account Setup

Create Password ) Confirm Identity ) Verification
Choose a secure new password and we'll log you right back in. New Password
Your new password must have: Enter New Password Again
* Uppercase letter ¢ Lowercase letter &
* Number * 12 to 50 characters -

No characters in order going up or down
( abc, cba, 123, 321) CANCEL
No characters repeated three or more

times in a row (aaa, 111, I, @)

Special characters (Optional)
JO#ES% &()_+=-
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Create Password

You will be required to create a new password during your initial logon to the system. The
guidelines for your new password are shown on the Create Password page. As you
create your new password, the guidelines will be displayed in green to confirm that your
password matches the criteria; otherwise, they will be displayed in red.

Account Setup

Create Password y Confirm ldentity Y Verification
Choose a secure new password and we'll log you right back in. New Password

----------- Q&

Your new password must have: [l Fiease enter a valid new password
Enter New Password Again

X Uppercase letter + Lowercase letter 9
v Number X12to 50 characters ?\_Q
v No characters in order going up or down =

( abc, cba, 123,321)

v No characters repeated three or more CANCEL

times in a row (aaa, 111, !, @@a)

v/ Special characters (Optional)
J@#ES%B &()_+=-
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Account Setup

Create Password

Confirm Your Identity

To confirm your identity and protect your account information, we'll send you a cne-
time verification code text*, or voice message.

Select how you would like to confirm your identity:

CANCEL SEND CODE

* Message and data rates may apply, including intemational rates (if applicable).

Phone

@® Text O Voice Message *-*'*-5211

Confirm Identity

Verification

What you should know

In order to protect your account information, we require you to confirm your identity before
accessing City National Online.

The contact information displayed on this page is the most current phone number on file;
please choose one of the verification methods shown to confirm your identity.

Note: For your security, portions of your contact information are masked, and displayed as

Verification

The third step in the Account Setup workflow will prompt you to confirm a verification
code sent to your email address or phone. Upon receipt of the code, enter the code
provided in the Verification Code field and click Verify to complete the verification
process. If the email was not received in your inbox, you can ask to have the verification
code resent by clicking the Select a different verification method link.

Account Setup

Create Password )

Verification Code

Do not close this page
For security purposes, the verification code you receive will NOT include a link back
to this page.

We've sent your verification code to: ***-***-5211

Verification Code

520803

CANCEL VERIFY
Didn't get your verification code?

Wait a few minutes or try a different verification method.

Confirm Identity
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E-Consent

Profile Setup

) A
E-consent Terms & Conditions :}Personal Infarmation ::: Security Questions

You must view and accept the e-cansent in order to continue.

Consent to Use of Electronic Communications and Electronic Signatures -
In connection with our relationship with you, we are required by law to give you certain

information “in writing” - which means you are entitled to receive it on paper. We need your
consentin order to provide you this information electronically instead. We also need your general
consent to use electronic records and signatures in our relationship with you. Please read the
information below carefully and thoroughly before you consent.

In this Consent, the words "we,” "us,” and "our” means City National Bank. The words "you"” and
“your” means the person giving consent. “Online Service” means each and every service we offer
that you apply for, enroll in, agree to, use, administer or access using the Internet, a website, email,
messaging services (including text messaging) and/or software applications (including applications
for mobile or hand-held devices), either now or in the future. “Communications” means each
disclosure, notice, agreement, undertaking, fee schedule, statement, record, document or other
information we provide to you or that you sign or submit or agree to at our request. “CNB Product”
means each account, product or service (including each Online Service) we offer that you own, .

| have read and agree to the terms of Consent to Use of Electronic Communications and Efectronic
Signatures.

| Accept Cancel
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Terms & Conditions

Profile Setup

E-consent L R e [iile]s 13 Personal Information "':j::- Security Questions

You must view and accept the terms & conditions in order to continue.

Terms and Conditions

These Terms and Conditions (this "Agreement”) apply to your online access to and use of certain
digital services ("Services") in connection with your deposit, treasury management and/or wealth
management accounts and services with City National Bank ("Bank") and/or City National
Securities (“CNS"). Your access to and use of the Services online is subject to the Terms and
Conditions Of Use for cnb.com (the "Website"), and any terms or instructions appearing on the
Website or otherwise provided to you in connection with enrolling for, activating, accessing, and/or
using the Services online. In addition, the account(s) and/service(s) accessed through the Services
remain subject to the separate agreements you have with Bank or CNS, applicable to such
account(s) and service(s).

To agree to this Agreement, click the | ACCEPT button below.

B | have read and agree to the Terms and Conditions.

| Accept Cancel

Personal Information

The next step in the first-time account setup process allows you to update your time zone
and add Email addresses and/or Phone Numbers so they are available later for sending a
verification code. You do not have to update this page, but if you do, click Save Changes
to move forward with the process.

e To update the Time Zone, select the appropriate time zone from the drop-down menu.

e To add additional phone numbers or emails, click Add Phone Number or Add Email
Address and fill out details.

e To remove an added phone number or email, click the Remove link.
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Profile Setup

i
E-consent } Terms & Conditions JEgSelaEIMIsiielanEld{elq] Security Questions

Review your personal information below. If your information is correct proceed to the next step. If not
select the information that you would like to edit.

Email Addresses
SUMMER.BREEZE@CNB.COM Primary

Add Email Address.

Phone Numbers

United States (+1) 213-° 521 Mobile 1 Primary

Add Phone Number.

Time Zone

US/Pacific, Pacific Standard Time

Change Time Zone

Security Questions

Security questions are challenge questions you set up that may be used to verify your
identity when you call in for support from a live support representative.
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E-consent "':j::- Terms & Conditions "':j::- Personal Information Security Questions

Update your security questions every so often to prevent security issues.

Security Question #1 . .
Security Answer Requirements
What is the last four digits of your social security v - Minimum 3 characters
- Maximum 50 characters
- Alphanumeric, ', -, and spaces are allowed
- Must be unigue

Answer

Security Question #2
What is your favorite sport? v

Answer

Security Question #3
In what city was your father born? v

Answer

Complete Cancel

Sign-In Assistance

If you forgot your User ID or password, you can click the Forgot User ID? or Forgot
Password? support links on the Sign In page. You will be asked to provide information to
receive assistance with retrieving your User ID or with getting a new temporary password.

You can also contact your company’s Administrator to assist you with resetting your
password.

July 2023 — City National Online General Overview




CiITY NATIONAL BANK %’

B AN RBC COMPANY

SIGN IN TO City National Online

User ID
City Mational Online

SUMMERE2

Business Suite™

Business Essentials Password

Remember my User ID

\ Forgot User ID?

Forgot Password?

NEW TO PERSONAL ONLINE BANKING?

ENROLL NOW

Dashboard & Widgets

The dashboard is the first screen you see after signing in to the Business Online portal. It
gives you the ability to personalize your banking experience by accessing widgets.
Widgets are module features that allow you to perform a variety of common tasks such as
quickly making a payment, transferring funds, stopping payment on a check, taking action
on tasks, and making positive pay decisions.

Note: This feature applies to the Business Suite and Business Essentials services. It does
not apply to E-Deposit, Account Reconcilement Processing, Account Services Manager
(ASM), or other services accessible through the portal.
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Dashboard

Account Summary

Groups I Reporting I Transaction Search

+ Deposit Accounts

Add Widget ~
Add Widget

Account Summary

Alerts Center

Audit Activity

Bank Account Settings

Check Issues

Checks and Stops Inguiry
Confidential Settings

Controlled Disbursement Reporting
Deposit Images

Exceptions

Export Maps

Exports

Import Files

Import Maps

Lockbox Availability

Lockbox Reporting

Notifications

Payees

Payment and Template Background Processing Status  ~

& D
Fitter | Select fields - | Set As Default My View v 5 Fiters
Account Name ‘ Account Number Ledger ‘ Available ‘ Net Activity Today .;:.
ACME Checking 1 23 160,454,510.64 160,457,032.10 2,521.46
ACME Payroll Account 1 75 1,270,486,175.31 1,270,492 474.90 6,209.59
CITY NATIONAL BANK25249 2 49 0.00 0.00 0.00

Viewing 1-3 of 5 records

Display per page ¢ Page El ofi2 3

Managing Dashboard Widgets

You can add widgets to your dashboard page and move existing widgets to different
locations on the page. You can also resize existing widgets and remove those you do not

want to use anymore.

Add a widget:

1. On your dashboard page, click the Add Widgets drop-down.

2. Select the desired widget from the list.
The newly added widget appears at the bottom of the page.

Resize a widget:

1. Click the Settings icon in the upper right-hand corner of the widget.

2. Click Resize. The widget is resized so that it takes up only half the width of the screen.
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3. Toreturn the widget to its original size, repeat steps 1 and 2.

Note: Some widgets with more information may not present well at half-size, such as
Account Summary or the Payments List.

Move a widget:

1. Left click the widget and, with the mouse button depressed, drag and drop the widget
above, below, or next to another widget on the dashboard.

Remove a widget:

1. Click the Settings icon in the upper right-hand corner of the widget.

2. Click Remove.

The widget is deleted from the screen. Removed widgets can be added again as desired.
Get help with a widget:

Many widgets provide a help option.

1. Click the Settings icon in the upper right-hand corner of the widget.

2. Click Help to see the appropriate help topic for the widget.

Customizing Your List View:

Many modules and features in the portal are organized in a list view. List views can be
updated and modified in a variety of ways to personalize your information and banking
experience.
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Dashboard

Account Summary

Groups I Reporting I Transaction Search

+ Deposit Accounts

Filter | Select fields

Add Widget v

O Refresh Balances  06/30/2023 08:58 AM

Ledger Available

(5) 1.439,86227029 143987109134

& R

Set As Default My View v | | 92 Filters

Account Name

Account Number Ledger ‘ Available ‘ Net Activity Today .;}
ACME Checking 1 3 160,454,510.64 160,457,032.10 252146
ACME Payroll Account 10 5 1.270,486,175.21 1.270,492,474.90 6,299.59
CITY NATIOMAL 21 9 000 000

Viewing 1-3 of 5 records

Display per page ¢ Pagelzl of2 »

Available Actions:

The Actions column allows you to take action on a single item in a list. Depending on the
item, you can view, modify, approve, or delete an item.

Value Date
O View = Entered 05/19/2023
O View Approve 511912023 ] An Actions Status

| Delete |
) View
Modiy () i Approved
Viewing 1-2 of 2 recor| )
g Reject O view Unapprove

Click the drop-down menu to view available actions. If only one action is available for an
item, access that function by clicking it.
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Navigating Through a List:

The total number of records and number of pages in a list is shown on the bottom of the
list view.

Viewing 1-10 of 302 records Display| 10 - |perpage Page| 1 ~ |of31 »

Click the arrows or the Page drop-down to navigate from one page to the next.

Viewing 1-100 of 302 records Display | 100 « |per page Page

TR R

Use the Display drop-down to select the number of records you want to appear on each
page.

Viewing 1-10 of 302 records Display| 10 ~ |perpage Page| 1 ~ |of31 3

3

5
10
25
50
100
250

Selecting a Predefined View:

Many lists have several predefined views beyond the default view. These pre-defined
views display records that meet specific criteria. For example, the Payments widget has
the predefined view Payments Requiring Approval, which shows all payments that still
need to be approved. A user who primarily approves payments may want to make this
their default view.

To use a predefined view:

1. Use the View drop-down located on the right side of the screen to select the view.
The drop-down lists the available predefined list views for this screen.

2. Select the desired view in the list. The displayed list view will change to the one you
selected.
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To set a new view as default:

1. Use the View drop-down to select the different view from the list.

2. Click Set As Default.

The selected list view will be the default each time you return to this list.
Filtering a List:

You can use the Filter drop-down to limit the records shown in a list of records that meet
specific criteria.

Lists can be searched using the quick search or the Manage Filters option. For simple
searches, use the quick search. For more complex searches, select Manage Filters.

To filter the list with the quick search:
1. In the Select Fields drop-down, select the field you would like to search by.
2. If necessary, select an operator from the list.

3. Enter the search criteria.

B

Click Apply. The records that meet the criteria you specified appear in the list view.
5. If you wish to search the entire list again, click Clear All and enter a new search.
To filter a list using the Manage Filters option:

1. In the Select fields drop-down, select Manage Filters. The Manage Filters window
displays.

2. Mark the boxes to select the fields to use as search criteria. If necessary, select an
operator such as is equal to or is greater than. If the field requires a date selection,
use the calendar pop-up to select a date.

3. Enter the search criteria.

4. Repeat steps 2 and 3 until you have selected as many filters as desired.
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Manage Filters

2 of 31 filters selected

W] Account Name
W] Account Number

{"}Bank Code
[ As-of Date/Time
Cecey

[ Ledger

pow

ACME FILMS

00100HABX

If you need to remove filters, uncheck the boxes to remove them.

5. When you have finished, click Apply to see the search results. The records that meet
the criteria you specified will appear in the list view. If you use the advanced filter
again, the system will search all of the items in the original list (not the filtered list).

6. Click Clear to remove the filter.

If you want to display what filters are in place, simply click the Filters Icon and then click it
again to remove it from the display.

Filter ‘ Select fields -

| Accoun it Type Cd, Dd, Mm, Sv Accounttype In False

edger >100,00000 &

Filter | Select fields -

Sorting a List:

A list can be sorted so that the order of the rows is reversed.
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To sort a list:

1. Click on the column header. The rows of data will be resorted. A down arrow
appears in the column to indicate the sort order.

2. To return the rows to their original order, click the column header again.
Moving Columns:
You can move columns to a new position on a list.
To move a column, drag and drop the column to the new position.
Adding or Removing Columns:

Columns can be added or removed from some lists in the application. If the list supports
this function, you will see the arrow icon in the header row at the right side of the list.

To add or remove columns:

1. Click the tool icon in the upper right corner of the List View. The available columns are
displayed. The checked boxes indicate which columns currently appear in the list
view.

2. Check or uncheck the columns you would like to include/exclude in your list, and then
click Update.

Refreshing a List:

A number of lists feature a Refresh icon in the upper-right corner. Along with the icon is a
notification of the most recent date and time.

When you click the icon, the list is refreshed and the date and time are updated. This will
be especially useful if you are working in a list for an extended period.

Saving a List View:

Once you have arranged a list view with the proper columns, sort order and filters, you
can save the list for future use.

To save a view:

1. Click the View drop-down in the top right corner of the list.
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2. Select Save View.

Deposit Accounts - CNB USD  »
| Deposit Accounts - CNB USD
Foreign Currency CD Summary-Prior Day

Foreign Currency Demand Summary-Prior Day

Multi-Bank Accounts

City
B AN R

NATIONAL BANK

BC COMPANY

Deposit Accounts - CNE USD -

+ Save view E

Deposit Accounts - CNE USD

Investment Sweep

i Filters

3. Inthe Save List window, enter a name for the list and click Go.

I Export & Print

Deposit Accounts - CNB USD -

My View] Go

Deposit Accounts - CNB USD

g Foreign Currency CD Summary-Prior Day

Deposit Accounts - CNEB USD =

I Y View

Deposit Accounts - CNB USD

Investment Sweep

& L

=) Filters

%

You can now access the list view from the My View drop-down every time you visit the list.
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Assigning the Default View:

The default view will be automatically selected every time you open a list.
To assign the default view:

1. Select the view you want to set as the default from the View menu.

2. Click Set as Default.

j Export g Print
- k Export &

Set As Defauli MY View =

= [

\

Set As Default My View - @ Filters

Removing a Custom List view:

You can remove list views that you have added; however, you cannot remove a default or
pre-defined list view.

To remove a view that you have added, select the View menu, and then click the trash
can icon next to the custom view you want to remove.
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